
1 | P a g e  
 

 

PRESIDENT’S MESSAGE    MESSAGE FROM THE EDITORS  
Duane L. Nelson  

Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. 
You can easily change the formatting of selected text in 
the document text by choosing a look for the selected text 
from the Quick Styles gallery on the Home tab. You can 
also format text directly by using the other controls on 
the Home tab. On the Insert tab, the galleries include that 
are designed to coordinate with the overall look of your 
document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document. 

On the Insert tab, the galleries include items that are 
designed to coordinate with the overall look of your 
document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document 
building blocks. Most controls offer a choice of using the 
look from the current theme or using a format that you 
specify directly. 

You can easily change the formatting of selected text in 
the document text by choosing a look for the selected text 

from the Quick Styles gallery on the Home tab. On the 
Insert tab, the galleries include that are designed to 
coordinate with the overall look of your document. You 
can use these galleries to insert tables, headers, footers, 
lists, cover pages, and other document. 

To change the overall look of your document, choose 
new Theme elements on the Page Layout tab. To change 

the looks available in the Quick Style gallery, use the 
Change Current Quick Style Set command. Both the 
Themes gallery and the Quick Styles gallery provide reset 
commands so that you can always restore the look of your 
document to the original contained in your current 
template.

 
 

 After 5 months of COVID quarantines and 
closures, calling these unprecedented times would be 
the understatement of the century.  We learned that 
even the wheels of justice have brakes.  Now, as we 
attempt to navigate through the various protocols that 
have been adopted by courthouses throughout the 
State, one cannot help but fear what looms on the 
horizon.  At some point, the flood gates shall open 

 

 

and trial calendars will become inundated with all the 
litigants whose cans have been kicked down the 
proverbial road.  Let's not forget all the new filings 
that will undoubtedly follow the settling of the dust.  
The words "force majeure" will ring from courtroom 
to courtroom.  If only we could better prepare 
ourselves for the unknown that is to come.  But who 
are we kidding?  Only hindsight is 20/20.  Or is it 
2020?  Next issue….protests, heat waves, and 
wildfires.     
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       Welcome to the 
Stanislaus County Bar Association.    Lawyers of 
Stanislaus County have consistently demonstrated a 
quality of law practice, and an integrity of 
professionalism, that is unequalled throughout the 
State of California, and throughout the country.    If 
you have a problem in Stanislaus County, you can 
always look for legal help to one of the local attorneys 
or law firms.   The lawyers of this community provide 
legal services to individuals and businesses of this 
County, which stand out in a growing, shrinking and 
competitive world.    I am proud to serve as President 
of the Stanislaus County Bar Association for the year 
2020.  

 

". . . EVEN THE WHEELS OF JUSTICE 

HAVE BRAKES."   

9/1/2020 
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 [October '20]:  

 

[November '20]:  Bench-Bar Dinner (TBD) 

 

[December '20]:  Judicial Calendar / Holiday Luncheon (TBD) 
 

For more dates and information, see the Calendar and Events pages on the SCBA website: 

https:// scbaweb.com /calendar 
 

  “AROUND THE OFFICES”    
 Attorney Flor A. Tataje has started her own firm doing Bankruptcy Law 

and now has the following contact information: 
 

Law Office of Flor A. Tataje 
1031 McHenry Avenue, Suite 20 
Modesto, California 95350 
(209) 410-9410 
Flor@tatajelaw.com 

 

If you work for a different firm, if your office/firm has moved, share your new information with the legal 
community for free – contact SCBA! 

 

SCBA CALENDAR OF EVENTS 

 

The Non-Sequitur seeks to serve its loyal Bar Association members.  If you have any 

announcements (i.e. job openings, office space vacancies, new hires, congratulations, condolences, 

etc.), please forward them to scba@scbaweb.com to be included in upcoming issues.  

mailto:scba@scbaweb.com
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The Honorable Hurl W. Johnson 
(Ret.) 

20 years with the Stanislaus County Superior 
Court 

Mediation and Arbitration Services 

Civil Cases: Contract & Commercial Disputes, 
Employment, 

Personal Injury, Insurance, Professional 
Malpractice, 

Probate and Family Law. 

Pepperdine University School of Law trained 
mediator 

(209) 809-2014 or (209) 524-1100 

Advertising 
For advertising opportunities, in the 
Non-Sequitur and/or the Bar 
Association's website, please visit: 

https://scbaweb.com/advertise-at-scba 

Job Openings  

 

 
• Haven Women's Center of 

Stanislaus looking for attorneys 
(See flyer in this issue.) 
 

• Hiring Associate with 1+ year 
experience.  Transactional and 
litigation practice.  Growth 
opportunity available.   
Contact John Gorman to apply.  
(209) 548-4000 or 
johnlgorman@sbcglobal.net 
 

Office Space 

 
 1203 14th Street  

(3 full service office rooms available) 
https://www.loopnet.com/Listing/1203-14th-St-Modesto-CA/20380833/ 

 
 

 1224 K Street 
(1,890 sf available) 
https://www.loopnet.com/Listing/1224-K-St-Modesto-CA/19283980/ 

 
 

 909 14th Street 
(4,100 sf available) 
https://www.loopnet.com/Listing/909-14th-St-Modesto-CA/15282288/ 

 
 

 909 15th Street 
(4,100 sf available) 
https://www.loopnet.com/Listing/909-14th-St-Modesto-CA/15282288/ 

                   

 

 

https://scbaweb.com/advertise-at-scba
https://www.loopnet.com/Listing/1203-14th-St-Modesto-CA/20380833/
https://www.loopnet.com/Listing/1224-K-St-Modesto-CA/19283980/
https://www.loopnet.com/Listing/909-14th-St-Modesto-CA/15282288/
https://www.loopnet.com/Listing/909-14th-St-Modesto-CA/15282288/
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ABIGAIL VAN DIEPEN - $1000 SCBA SCHOLARSHIP RECIPIENT 

Abigail Van Diepen graduated from Thomas Downey High School in the top 5% of her class and 
will be attending UCLA in the fall. Abigail intends to get her degree in political science and to 
pursue a career as a social justice lawyer. Abigail feels a responsibility to advocate for those who 
are struggling in this world and has been a volunteer for Community Hospice, Leukemia 
Lymphoma Society, Modesto Covenant Church and Stanislaus Youth Soccer League. Additionally, 
Abigail is a four year member of the Science Bowl and served as a California Scholarship 
Federation President for one year. 

KAITLYN RIDENOUR - $1000 SCBA SCHOLARSHIP RECIPIENT 

Kaitlyn Ridenour is a graduate of Enochs High Schools graduating with a cumulative GPA of 
3.80. Kaitlyn was born into a law enforcement family which has inspired her future career goal of 
becoming a district attorney. Kaitlyn will be attending the University of California Santa Barbara 
in the fall majoring in Sociology and then plans to attend law school after graduating. For the past 
twelve years, Kaitlyn has been involved in Girl Scouts and with over 50 hours of volunteering, she 
was able to work alongside her troop to donate money to Kate's Rescue which is a local shelter. 

 

SCBA Scholarship Fund 
The Bar Association is collecting scholarship donations to fulfill our 2020 goal of two $1,000 

Scholarships to award to Stanislaus County High School seniors. Please send donations to "SCBA" at: 

802 14th St, Suite O 
Modesto CA 95354 

 

SHANNON PAULSON - $1000 MODESTO 500 LIONS CLUB/SCBA SCHOLARSHIP 
RECIPIENT 

Shannon Paulson is a graduate of Gregori High School graduating in the top 5% of her class who 
will be attending University of California, Berkeley in the fall to study Environmental Economics 
and Policy with plans of studying environmental law. Shannon worked for the past four years as a 
student mentor for Teens Run Modesto (a 26 week marathon training program) and competed in 
Mock Trial. Shannon realized her passion for Environmental Policy while she was arguing a round 
of Empire Mock Trial where she argued a case about environmental contamination and its 
disproportionate damage to economically disadvantaged communities. 

CONGRATULATIONS TO THE 2020 SCHOLARSHIP RECIPIENTS! 
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Lawyer’s Referral Service 
 Are you willing to support your local Bar Association?  
 Are you looking for new clients? 
 Are you willing to provide some pro bono time? 

 

IF YOU ANSWER “YES” TO ANY OF THE ABOVE, PLEASE 
CONSIDER SERVING ON THE LRS PANEL. 

 As an SCBA member, you only pay a $50 annual LRS panel fee! 

 

Simple appointment process: LRS representative will schedule appointments with 
your office at your convenience with clients who have a matter in your area(s) of 

expertise. The client pays a $50.00 admin. fee to us over the phone, for a 30-minute 
consult. More questions? Call us at (209) 571-5729. 

https://scbaweb.com/lawyer-referral-service 

 

 

 

 

 

 

 

 

 

 

 

 

Stanislaus County Legal 
Professionals Association 

We have resumed our meetings via Zoom! 

Meetings are open to anyone and our goal is to 
provide continuing education for those in the 
legal field as well as scholarship opportunities 
for those studying to become support staff in 
the legal field.  Our next Board Meeting will be 
on September 2 at noon and our next 
Membership meeting will be on September 9 
at 6:00 p.m. 

For more information you can contact 
SCLPA’s President, Maureen Harrity at: 

mharrity@leemodelaw.com 

https://scbaweb.com/lawyer-referral-service
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  CONDOLENCES 

Charles Brunn, a native San Franciscan, graduated from St. Ignatius College Preparatory 
in 1949, and received his Bachelor of Science and Juris Doctorate degrees from the 
University of San Francisco. He served in the United States Navy aboard the USS Pasig 
during the Korean War. He married Mary Ellen O'Brien in San Francisco, and they 
moved to Modesto in 1959, where Charles began a long and illustrious career as a trial 
attorney. He was an icon, friend, and mentor to attorneys throughout California. 
Charles founded the Law Offices of Brunn & Flynn, and his work on the "Queen's 
Case" was featured on the television show, "Forensic Files". Charles taught Business 
Law at Stanislaus State, served as the President of the Stanislaus County Bar 
Association, was a member of the American Board of Trial Advocates, and was rated 
"AV-Preeminent" by Martindale-Hubbell. Charles was a long-time member of the 
Modesto Serra Club and the downtown Rotary Club. He was a member of St. Joseph's 
Catholic Church in Modesto. 

 

Frank Carson 
Jun 29, 1954 – Aug 12, 2020 

Charles Kenneth Brunn 

Dec 3, 1931 – Jul 10, 2020 

Frank Clifford Carson was born June 29, 1954, in Modesto. He attended 
Lincoln Law School in Sacramento and was admitted in 1988 to the State Bar. 
He worked for the Stanislaus County Public Defender’s Office before 
opening a private practice in 1996.  Colleagues have been quoted saying of 
Frank, “He really was a great interrogator and brilliant at closing 
arguments” . . . “He was persistent and took the hard cases, and he stuck with 
it” . . . "Frank was a very smart, very intelligent lawyer”. . . “He was a really 
good man. He cared about his clients. He fought for his clients." 
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Did you know . . . 
On July 16, the California Supreme Court 
announced it will permanently lower the 
passing score for the California Bar Exam to 
1390 and released plans for an exam 
administered online October 5-6. Registration 
for the October exam is extended through July 
24. The State Bar will also expedite creation of 
a provisional licensure program under 
supervision for 2020 law school graduates—
effective at least until June 1, 2022, or until they 
can take and pass a California bar exam. Read 
the Court's letter to the State Bar. 

 

 

M.C.L.E. 
H-M Deadline to report: 2/1/21 

A-G Deadline to report: 2/1/22 

N-Z Deadline to report: 2/1/23 

 

Changes in Law 
Did you know nearly 70 new and amended 
Rules of Professional Conduct took effect 
on November 1, 2018?  Click below: 

http://www.calbar.ca.gov/About-
Us/News/News-Releases/new-rules-of-
professional-conduct-effective-november-1 

STILL TIME TO FINGERPRINT 

At its May 14, 2020 meeting, the Board of 
Trustees approved to extend the Fingerprinting 
Rule requirement deadline from June 30, 2020 
to September 30, 2020, to mitigate the impact of 
the COVID-19 emergency on licensees and Live 
Scan providers.    

 

At least for now, gone are the days that you can stroll 
on down to your favorite Downtown Modesto restaurant for 
lunch.  On the very small bright side of this pandemic, many 
restaurants are turning to delivery which gives us a much 
wider variety of choices.   

This issue's focus is on Fresh Fork Grill.  Their 
motto, "Never Fried. Never Frozen. Never Fake." says it all.  
It's a delicious and healthy alternative for not only the noon 
hour, but any time of day.  The owners, Martin and Carmina 
Magallanes, also own and operate a local gym that focuses on 
weight loss through a proven workout and diet program.  
Motivated to help people, Martin and Carmina created Fresh 
Fork to give our community a new option for eating healthy 
on the go. 

Fresh Fork boasts a simple menu, with no guilt and a 
whole lot of flavor.  Portions come in three sizes (i.e. Plate, 
Bowl, or Little Bowl).  You choose a protein (i.e. grilled 
chicken, steak, salmon, or shrimp), pair it with white or brown 
rice, and select between mixed vegetables or broccoli on the 
side.  You can mix meats or forego them altogether and opt, 
instead, to go with tofu or the vegetarian plate.  You can also 
skip the carbs and turn it into a salad.  Add the Fork'n Sauce 
on the side and you'll find a meal that you keep going back to.  
The best part is that you can go right back to work without 
that sleepy, call it a day, feeling.   

Fresh Fork Grill is available on Grubhub.  You can 
also visit their website www.freshforkgrill.com to order online 
and have it ready for pick up within minutes.  They are located 
just off the Highway 99, Mitchell Road exit, in Ceres.   

3018 Service Road, Ceres, Ca 
(209) 566-8363 

www.freshforkgrill.com  
 

https://newsroom.courts.ca.gov/_gallery/get_file/?file_id=5f10f6e92cfac2089661af1f&ir=1&file_ext=.pdf
https://newsroom.courts.ca.gov/_gallery/get_file/?file_id=5f10f6e92cfac2089661af1f&ir=1&file_ext=.pdf
http://www.calbar.ca.gov/About-Us/News/News-Releases/new-rules-of-professional-conduct-effective-november-1
http://www.calbar.ca.gov/About-Us/News/News-Releases/new-rules-of-professional-conduct-effective-november-1
http://www.calbar.ca.gov/About-Us/News/News-Releases/new-rules-of-professional-conduct-effective-november-1
http://www.freshforkgrill.com/
http://www.freshforkgrill.com/
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Handling COVID-19 in the Workplace 
 

By:  James R. McDade, of Counsel, McCormick Barstow, LLP 
08-07-2020 

 
Dealing with COVID-19 in the workplace is very difficult because the science is not complete and the 
government guidelines and rules keep changing.  There is also the practical implications of employees 
not being able to get tested and/or not being able to get timely test results.  In addition, dealing with 
COVID-19 in the workplace involves many labor and employment laws, regulations, and policies.  The 
following are suggestions for dealing with COVID-19 in the workplace.  The following suggestions might 
not cover all the possible situations you may encounter.  If there are possible concerns or implications to 
your business or your employees, or if you have any questions, please contact your legal counsel.  Also 
note that some actions that an employer can take under the Americans with Disability Act (ADA) and Fair 
Employment and Housing Act (FEHA) related to asking employees about medical information, taking 
temperatures, etc., are only allowed due to there being a pandemic.  Therefore, the information below is 
specific for handling COVID-19 situations only. 

A. Suggested Steps If An Employee Reports Exposure To Or Symptoms Of COVID-19 

1. If an employee reports that the employee has been exposed outside the workplace to 
someone who has a confirmed case of COVID-19, or reports that the employee is 
experiencing COVID-19 symptoms, have the employee not report to work.  If an employee is 
at work and indicates that the employee is experiencing COVID-19 symptoms, send the 
employee home.  Unless and until it is reasonably determined that the illness is not related to 
COVID-19, the employer should just assume that an employee who is experiencing COVID-
19 symptoms has COVID-19, and act accordingly.   

2. Review the local county Health & Human Services Agency (HHSA) requirements for reporting 
COVID-19 exposures and infections.  If reporting is required, instruct the employee to self-
report.  Otherwise, get the employee’s permission (in writing) to reveal the employee’s name 
and personal information to the county HHSA.  Be ready to share with HHSA certain 
information about co-workers who came into “close contact” with the employee.  Follow the 
local HHSA rules and healthcare provider’s orders for taking the employee off work.  If your 
local HHSA has no requirements for dealing with COVID-19 in the workplace, seek information 
from the US Centers for Disease Control (CDC), your workers’ compensation carrier, work 
wellness center, and Cal-OSHA, and legal counsel for how to proceed. 

3. Document (i) what symptoms the employee reports as having, if any, (ii) whether the 
employee is seeking a medical diagnosis (i.e., going to the doctor) or is otherwise waiting to 
be tested for COVID-19, and (iii) if the employee has been told by the county HHSA or a 
healthcare provider to quarantine.  This information is needed to determine if Emergency Paid 
Sick Leave (EPSL) under the Families First Coronavirus Response Act (FFCRA) is applicable.  
Remember, all medical information (such as symptoms and testing results) must be kept 
confidential and separate from the employee’s regular personnel file. 
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4. If the employee contracted COVID-19 at work, record the illness on the proper Cal-OSHA 
injury log report if your business is required to maintain a log, and report the illness to Cal-
OSHA.  Visit the Cal-OSHA website for reporting requirements.  Also report the illness to the 
workers’ compensation carrier to determine if a claim needs to be made.  Note that Governor 
Newsom signed Executive Order N-62-20 on May 6, 2020, creating a presumption that an 
employee has a workers’ compensation clam if the employee tests positive for or is diagnosed 
by a physician with COVID-19 within 14 days of having worked at the employer’s worksite. 

5. Without revealing the name of the employee, notify all co-workers of possible COVID-19 
exposure.  Those who had close contact with the infected or potentially infected employee 
should also be quarantined as directed by HHSA and/or a healthcare provider.  The 
Department of Fair Employment and Housing (DEFH) suggests the following notice:  
“[Employer] has learned that an employee at [office location] tested positive for the COVID-
19 virus.  The employee received positive results of this test on [date].  This email is to notify 
you that you have potentially been exposed to COVID-19 and you should contact your local 
public health department for guidance and any possible actions to take based on individual 
circumstances.”  To help alleviate concerns of co-workers, let the co-workers know that the 
infected employees will remain off work until the criteria of the HHSA is met.  Place a sign on 
the front door notifying customers and vendors that there is a possible COVID-19 exposure in 
the workplace and that all precautions are being taken to protect employees and visitors from 
future exposure.  List a phone number of someone they can talk to without having to go inside.  
This will help customers decide on their own if they want to enter the building or not. 

6. Follow your Injury and Illness Prevention Plan (IIPP) procedures.  Thoroughly disinfect the 
worksite, especially those areas used by the potentially infected employee, including all 
common areas, such as lunch rooms and rest rooms.  Train employees on how to keep 
themselves and others safe. 

7. Pay the employee EPSL if the employee meets the criteria for payment.  If the local HHSA 
instructs the employee to quarantine, then the employee might be eligible for EPSL, even if 
the employee has no symptoms.  If the employee is taking care of an immediate family 
member or roommate at home who is either subject to a Federal, State or local quarantine or 
isolation order, or has been advised by a healthcare provider to self-quarantine, then the 
employee might be eligible for EPSL.  If the employee is experiencing COVID-19 symptoms, 
the employee must ALSO be seeking medical diagnosis in order to qualify for EPSL.  If the 
employee can work from home, then the employee will not qualify for EPSL payments.  Get 
the EPSL certification statement from the employee as required by 29 CFR §826.100.  
Determine if any other company-provided paid leave or government wage replacement 
programs are available.   

8. Follow the local HHSA rules and healthcare provider’s orders for returning the employee to 
work.  Some counties require the employee to quarantine and remain off work until all of the 
following is accomplished: 

i. At least 14 days have passed since exposure date; 
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ii. No fever (temperature above 100.4 F) for 3 full days, without the use of fever 
reducing medicine, and; 

iii. Other symptoms have improved. 

Note that the CDC guidelines (which can be found at CDC.gov) can be different than 
the county HHSA rules, so follow the HHSA rules.  If there are no HHSA rules, follow 
the CDC guidelines. 

Some HHSA rules and the CDC define “exposure” and “exposed” to mean (1) having greater 
than 15 minutes of face-to-face (less than 6 feet distance) contact, (2) living or sleeping in the 
same house, (3) sharing kitchen or bathroom facilities, (4) closed space contact, (5) being on 
an aircraft within two seats of a confirmed case of COVID-19, or (6) having unprotected direct 
contact with secretions or excretions (getting sneezed or coughed on; picking up used tissue, 
etc.). 

Some HHSA follow the CDC guidance that certain “low risk” and “medium risk” essential 
workers who have been exposed to COVID-19 and who are asymptomatic can remain on the 
job if they are monitored (see below on monitoring employees).  The local HHSA will help the 
employer evaluate the situation on a case-by-case basis. 

If the employee can work from home, allow the employee to do so.   

If the employee is allowed to continue to work at the place of business per HHSA rules, then 
those co-workers who are at-risk or taking care of someone who is at-risk of serious 
complications from COVID-19 should be given the choice, if possible, to work from home or 
stay home during the 14 day incubation period in order to see if those exposed to COVID-19 
develop symptoms.  An at-risk co-worker may qualify for EPSL if a medical healthcare provider 
instructs the co-worker to stay home due to COVID-19 concerns.  Otherwise, the co-worker 
should be allowed to use vacation. 

B. Doctor’s Notes 

Because the employee’s actual or potential infection from COVID-19 endangers the health of 
others, you can, under the ADA and FEHA, require an employee to provide a doctor’s note clearing 
the employee to work.  The employer should pay the doctor’s fee or co-pay for obtaining a doctor’s 
clearance if the employer is requiring the clearance.  If the county HHSA so directs, a doctor’s note 
might not be needed. 

C. COVID-19 Testing 

Under the ADA and FEHA, employers can require the employee to take a COVID-19 test prior to 
entering the workplace due to the pandemic situation.  See the Equal Employment Opportunity 
Commission (EEOC) publication “What You Should Know About COVID-19 and the ADA, the 
Rehabilitation Act, and Other EEO Laws”, and the DFEH publication “DFEH Employment 
Information on COVID-19” for more details on testing requirements.  If the employee is tested too 
early after exposure, the test result may be a false negative.  Any employer-required testing should 
be paid for by the employer.  If the test is administered at work, then there is no question that the 
employee needs to be paid for being under the control of the employer, which includes the time 
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waiting to be tested, the time it takes to test, and the time it takes for the result to come back.  
Reporting time pay may also be applicable if the employee is sent home because the test is positive.  
If the employer requires the test off-site, such as a follow up to the employee reporting an illness, 
it is unknown if the employer has to pay the employee for the time it takes to arrange and take the 
test.  The EEOC and DFEH both state that employers may not require employees to take COVID-
19 antibody testing (which is different the regular COVID-19 viral testing) as a condition of returning 
to work.  Proper medical procedures and proper confidentially protocols must be followed.  Also 
review the Cal-OSHA rules for keeping test results. 

D. Work from Home 

An employer can consider allowing employees to work from home.  In fact, allowing an employee 
who is experiencing COVID-19 symptoms to work from home can be a reasonable accommodation 
required by the ADA/FEHA.  The employer should provide guidance to employees on wage and 
hour matters, such as clocking in and out, not allowing for working off-the-clock, taking 
uninterrupted rest and meal breaks on time, and paying for expenses associated with working at 
home, including paying for travel time and vehicle expense for running errands, getting supplies, 
and using cell phones or land lines and internet service.  The employer also has an obligation to 
provide a safe working environment wherever the employee is working, so the employer might 
have the obligation to conduct some type of inspection of the at-home workplace (including office 
furniture) under the employer’s Injury and Illness Prevention Program (IIPP).  While federal OSHA 
Instruction 02-25-2000 CPL 02-00-125 states that employers are not liable for and do not have to 
inspect “home offices,” Cal-OSHA has not issued any clear instruction on the topic.  “Home office” 
means a place where office work such as typing, reading, copying, phones calls, etc., is done.  
Home manufacturing is a different story.  Contact your workers’ compensation carrier and Cal-
OSHA about home-worksite safety.  In addition, the employer should make sure its workers’ 
compensation insurance, liability insurance, and vehicle insurance will cover the employee who is 
working at home.  If the employee is working from home, then any travel time associated with 
working starts and ends at the employee’s home.  The employer should also make it clear that 
working at home is a temporary arrangement intended to meet the COVID-19 crisis and is not a 
permanent solution and can be revoked at any time for any reason or no reason. 

E. Safety of Employees 

Even if you do not have to cease operations under any state or local stay-at-home orders, Cal-
OSHA requires that employers provide a safe and healthy workplace.  Otherwise, the employer 
could face a “serious and willful” violation under Labor Code 4553 which provides for a penalty 
equal to one-half of the workers’ compensation award.  Hence, the employer will want to show that 
it took all reasonable actions to protect the employee.  The employer will also want customers to 
feel safe.  You should evaluate each job to determine what safety measures should be put into 
place such as (a) disinfecting the workplace regularly and often; (b) telling employees that they 
should not come to work sick or if they were exposed to COVID-19; (c) training employees on 
proper hygiene and other preventive measures; (d) finding new ways to deal with customers, such 
as video conferencing; (e) allowing employees to work from home; (f) providing masks and gloves 
to employees (with proper training for use), (g) setting up plastic barriers between employees and 
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customers, etc.  For information on protecting workers, visit 
https://www.dir.ca.gov/dosh/coronavirus/Health-Care-General-Industry.html.  If you cannot take 
reasonable steps to protect your employees from catching the virus, especially those at high risk, 
then seriously consider temporarily closing your business.  

F. Monitoring Employees 

All employees, including those who have had COVID-19, should continue to monitor their health.  
Employees should be told that they are to notify their supervisor if they are not feeling well at work.  
Employees should also be trained on screening themselves for COVID-19 symptoms and told not 
to report to work if they have any symptoms.  Pursuant to the EEOC and DFEH, employers can 
use a pre-shift COVID-19 screening questionnaire which asks employees if they are experiencing 
any COVID-19 symptoms, have been exposed to someone with COVID-19, or ordered to isolate 
or quarantine.  Information about symptoms is medical information which the employer must keep 
confidential and separate from the employee’s regular personnel file.  Visit the CDC website for a 
current list of COVID-19 symptoms, which currently includes fever or chills, cough, shortness of 
breath or difficulty breathing, fatigue, muscle or body aches, headache, new loss of taste or smell, 
sore throat, congestion or runny nose, nausea or vomiting, and diarrhea.  Some cities and counties 
require employers to make daily inquiries of their employees for specific symptoms.  Review your 
county HHSA website for those requirements. 

G. Taking Temperatures 

Taking a temperature is a medical exam under the ADA and FEHA and a medical exam may only 
be performed under the proper circumstances.  The EEOC has said that taking the temperature of 
employees is currently allowed due to the COVID-19 crisis.  The DFEH also allows the taking of 
temperatures for COVID-19 purposes.  (See “DFEH Employment Information on COVID-19” FAQ)  
Realize, however, that having or not having a temperature at any particular moment in time may 
or may not be proof positive that employee does or does not have COVID-19.  If temperatures are 
taken, a proper system needs to be implemented that includes: (1) using someone trained on 
taking temperatures; (2) the person taking the temperatures should have PPE and practice proper 
procedures to avoid cross-contamination; (3) the temperatures should be taken in location before 
the employee contaminates other locations in the building; (4) the temperature taking location 
should be private so that medical information (which includes the temperature) is not revealed; (5) 
disinfecting protocols if someone does have a temperature; (6) protocols for dealing the employees 
with a temperature of 100.4º or more, including:  discreetly allowing an employee to go home; 
informing the employee how to get tested for COVID-19; paying reporting time pay (see below); 
providing notices of benefits available to the employee; and following all mandated leave 
requirements; and (7) informing co-workers of potential exposure as discussed below without 
revealing the name of employee who potentially has COVID-19.  

H. Reporting Time Pay 

Remember that if you send an employee home from work, you have to pay the minimum “reporting 
time pay” as required by the applicable Wage Order.   

https://www.dir.ca.gov/dosh/coronavirus/Health-Care-General-Industry.html
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I. Salaries for Salaried, Exempt Employees 

Do not forget to continue to pay the full salary of exempt, salaried employees who are ready to 
come to work, but who are told not to work.  Otherwise, you can lose the overtime exemption for 
the workweeks in which the salary was not paid.  If the employee is sick and cannot work, or cannot 
work because the employee has to care for a child, review the rules for when a deduction from the 
monthly salary can be made for the time not worked.  Normally, if the employee works any part of 
the workweek, the full salary must be paid.  The law allows certain deductions from sick leave and 
vacation banks for absences of a partial day or week.  See https://www.dir.ca.gov/dlse/2019-Novel-
Coronavirus.htm for more information. 

J. California Consumer Privacy Act (CCPA) 

If your business is subject to the CCPA, then you may have to provide employees a CCPA-
compliant notice prior to or at the same time as your collection of certain medical information about 
the employee.  Seek legal counsel on this subject.   

K. Other Resources 

The following are some websites with additional information and resources that can help you stay 
informed and provide additional guidance on dealing with COVID-19: 

(a) https://www.dol.gov/coronavirus 

(b) https://www.dir.ca.gov/dosh/coronavirus/Health-Care-General-Industry.html.   

(c) https://www.dir.ca.gov/dlse/2019-Novel-Coronavirus.htm 

(d) https://www.labor.ca.gov/coronavirus2019/ 

(e) https://www.cdph.ca.gov/Programs/CID/DCDC/Pages/Immunization/ncov2019.aspx# 
(f) https://www.cdc.gov/coronavirus 
(g) https://www.sba.gov/page/coronavirus-covid-19-small-business-guidance-loan-resources  
Other resources are available from the Society of Human Resources (SHRM) and the California 
Chamber of Commerce (HR California).  Obtain legal advice from an attorney prior to taking drastic 
workplace measures or potential adverse action against an employee. 

 

https://www.dir.ca.gov/dlse/2019-Novel-Coronavirus.htm
https://www.dir.ca.gov/dlse/2019-Novel-Coronavirus.htm
https://www.dol.gov/coronavirus
https://www.dir.ca.gov/dosh/coronavirus/Health-Care-General-Industry.html
https://www.dir.ca.gov/dlse/2019-Novel-Coronavirus.htm
https://www.labor.ca.gov/coronavirus2019/
https://www.cdph.ca.gov/Programs/CID/DCDC/Pages/Immunization/ncov2019.aspx
https://www.cdc.gov/coronavirus
https://www.sba.gov/page/coronavirus-covid-19-small-business-guidance-loan-resources
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Contact George Rodarakis for tickets (209) 554-5232 or grodarakis@rodsoulaw.com 
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Stanislaus County Bar 
Association 

802 14th Street, Suite O 
Modesto, CA 95354 

 

 

 

 

 

 

Stanislaus County Superior Court COVID updates 

https://www.stanct.org/ 

 

Legal Resources: 

https:// scbaweb.com /resources 

2020 SCBA OFFICER’S & BOARD OF DIRECTOR’S 
OFFICERS:  
 
PRESIDENT: Duane L. Nelson; Damrell, Nelson, Shrimp, Pallios & Silva 

V.P.: George P. Rodarakis; Rodarakis & Sousa, APC 

SECRETARY: Sonya A. Bouma; Law Office of Sonya A. Bouma 

TREASURER: Colleen Van Egmond; Arata, Swingle, Van Egmond & Heitlinger 

BOARD OF DIRECTORS  

• Betty L. Julian; McCormick Barstow, LLP 

• Tamie L. Cummins; Borton Petrini, LLP 

• Andrea M. Leavy; Goss & Goss, APC 

• Maria Jaime; Curtis Legal Group 

 

 

 

SCBA FACEBOOK PAGE: https://www.facebook.com/stancountybar/ 

REFER SCBA TO OTHERS 
Top Ten Reasons To Join the SCBA 

https://scbaweb.com/top-ten-reasons-to-join 

Just Joking . . . 

 

 

 

https://www.stanct.org/
https://stanbar.org/resources
https://www.facebook.com/stancountybar/
https://scbaweb.com/top-ten-reasons-to-join
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